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1 Introduction 

Welcome to the Hazus Comprehensive Data Management System (CDMS). CDMS is a Hazus 

support tool that allows users to move data to and from Hazus state datasets. Hazus is a natural 

hazard modeling application that estimates the social and economic impacts from hurricanes, 

floods, earthquakes, and tsunamis. Hazus provides tools to users to assess the impacts of 

various mitigation strategies that can be used to help address the issues created by hazards. 

Hazus uses hazard damage information to estimate direct dollar losses for: 

• Buildings

• Lifelines

• Regional economy

In addition, Hazus can answer questions such as: 

• Will building code modifications minimize losses?

• Will levee or flow regulation structures protect properties?

Hazus focuses on two major areas of damage and loss estimation: infrastructure-related 

damage and population impacts. The three keys to a successful Hazus analysis are credible 

hazard data, credible damage functions, and credible inventory. The third key is the domain of 

CDMS. Users can use CDMS to update the default Hazus inventory data with local and expert-

influenced data that will make the loss estimations more credible. 

The purpose of CDMS is to provide a uniform approach to importing and managing Hazus 

datasets. 

The system supports a variety of methods to help users manage information, including: 

• Site-specific inventory data (e.g., Essential Facilities, User-Defined Facilities [UDFs]).

• Aggregated general building stock data (e.g., building counts by tract, square footage,

exposure).

• Building-specific data.

CDMS validates user data to ensure that the data are Hazus compliant. CDMS prevents faulty 

data from entering the Hazus state datasets. The user must make sure the datasets that are 

produced or edited outside Hazus maintain an appropriate level of integrity. Much of this effort is 

related to ensuring that the data exported from Hazus have been updated correctly (e.g., 

appropriate domains, values, formats) and that any data originating outside Hazus are brought 

into compliance (e.g., required fields, modeling values). 

CDMS is not intended to eliminate the need to prepare data prior to integration into the Hazus 

data structure. CDMS is simply a tool to streamline the data integration process. There are no 

data maintenance tools (editing or viewing) in CDMS. Data update and management occurs 

outside of CDMS, and then CDMS is used to update the default Hazus state datasets. 
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Significant user enhancements have been introduced to CDMS in the Hazus version 4.2 

release, including: 

• All state databases were reprojected from North American Datum of 1983 (NAD83) to the

World Geodetic System 1984 (WGS84), and all dasymetric census block geometries were

repaired.

• The fields of Landslide Susceptibility Category, Liquefaction Susceptibility

Category, Soil Type, and Water Depth were added to the Data Field Matching screen,

and defaults are provided when the Advanced Engineering Building Module (AEBM) or

UDF data are being imported.

• CDMS will now filter hazard-specific fields when a hazard type is selected for data import;

this avoids flood fields being visible for earthquake data import, etc.

• Required fields for Transportation, Utilities, and UDF now display in the same font color

as required fields in other data types.

• The NumStories field now displays correctly as a required field.

• Counties in Alaska, Louisiana and South Dakota received new names in the census;

databases were updated with the correct names.

• Cities and counties that share the same name are now differentiated with a “city” notation

after the city name.

• An error message now displays when users attempt to load data from one state into

another.

• Default replacement costs are provided for Building and Contents when a user imports

AEBM or UDF data that have null values for these fields. Building and Content Cost are

calculated using the Hazus methodology from the Hazus Flood Technical Manual

Inventory Chapter 3, including the use of income ratio to adjust Single Family Dwelling

(RES1) replacements costs.

• Default estimates of the number of Day and Night occupants based on relationships

between number of occupants related to building area and occupancy types are provided

when a user imports AEBM data with null values for those fields.

• A divide by zero error was resolved during import of COM10 occupancy data in AEBM.

• The EQ Building Type field no longer displays twice when importing site-specific data.

• CDMS can be used to import User Defined Inventory Data for tsunami anyalsis. UDF

tables are updated within the State Database in Hazus, using the enhanced CDMS UDF

interface. The design of Tsunami UDF utilizes attributes that are already part of the

earthquake- and flood-specific UDF tables.

1.1 Site-Specific Inventory Data 

The site-specific inventory has various capabilities allowing the user to import, update, query, 

export, and delete data: 
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• Import/update inventory data from a user provided file: MS Excel Spreadsheet (.xls),

MS Access database (.mdb), Esri shapefile (.shp), and Esri personal geodatabase file

(.mdb).

• Import/update inventory data from a Hazus Study Region.

• Query/export inventory data to an MS Excel spreadsheet or an Esri personal

geodatabase.

• Delete inventory data.

1.2 Aggregated General Building Stock Data 

The aggregate general building stock data allows the user to capture and update combined 

datasets, including: 

• Update aggregate data from a user-provided file containing individual building or parcel

data in MS Excel spreadsheet (.xls), MS Access database (.mdb), Esri shapefile (.shp),

and Esri personal geodatabase file (.mdb) formats.

• Update aggregate data from information that has already been summarized according to

existing Hazus data structures (e.g., Demographics, Square Footage by Census

Block).

• Update aggregate data from a Hazus Study Region.

• Update aggregate data from information in the building-specific data model of CDMS.

1.3 Building-Specific Data 

CDMS allows users to import, update, query, and export specific data associated with building 

information: 

• Import building-specific data into the building-specific data model for refinement and

tracking.

• Update and aggregate the general building stock from building-specific data.

• Query/export state data by county, census tract, or census block in MS Excel (.xls) or Esri

personal geodatabase (.mdb) formats.

1.4 Data Transfer 

CDMS supports the transfer of data into and out of a state dataset and offers validation of new 

data brought into the system. Figure 1-1 is an example of CDMS functionality. 



Figure 1-1: CDMS Functionality 

Updating Hazus Inventory Data 

Example: Quarterly Update of Essential Facilities 

• Schools  

• Police Stations 

• Fire Stations 

• Medical Care Facilities 

• Emergency Operations Centers 

Export data from Hazus using CDMS and distribute to 

local agencies for update 

Agencies update the data using available tools (MS 

Excel, MS Access, GIS) 

Import the updated data into the CDMS Data Repository 

Use the updated Essential Facilities data in a new Hazus 

analysis 

Package the updated Hazus data and distribute to other 

Hazus users 

 

CDMS is designed for the existing Hazus data structure. As outlined in Figure 1-2, the CDMS 

system will accept information in a variety of user-supplied formats. CDMS contains field 

matching and validation routines to allow the user to control data import. Once validation occurs, 

data are maintained within the CDMS Repository until the user requests that the data be 

merged with the Hazus database for their state. 

Figure 1-2: Workflow for Updating Hazus Data Using CDMS 
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2 CDMS Menu Options and General Functionality 

The CDMS application installs with the Hazus software. To launch CDMS, from the Windows 

Start button, choose All Programs > FEMA Risk Assessment System > CDMS or double click 

the desktop icon. 

The CDMS Home screen serves as the central location from which data modification activities 

can be started. Once launched, the CDMS Home screen can be returned to from any screen in 

the system. The CDMS Home screen items include: 

• CDMS Repository. 

• Statewide Layer Modification History. 

• Functionality options buttons. 

The CDMS Repository, as shown in the top half of the CDMS Home screen in Figure 2-1, 

stores any user data that have been imported and converted to the Hazus data structures. Data 

visible in this window have not yet been merged or transferred to a Hazus state dataset. 

Figure 2-1: CDMS Repository 
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The Statewide Layer Modification History is in the bottom half of the CDMS Home screen, as 

shown Figure 2-2. This window is where the data appear after the data have been merged with 

a Hazus state dataset. 

Figure 2-2: Statewide Layer Modification History 

 

 

 

The left side of the CDMS Home screen contains five functionality buttons that allow navigation 

to other system functionality. The Current State and the Exit CDMS buttons are also displayed 

in this part of the CDMS Home screen (Figure 2-3). 
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Figure 2-3: CDMS Functionality Options 

 

2.1 General Functionality 

The menu bar contains items related to general system functionality: File, Tools, and Help. 

2.1.1 File Menu 

The File menu offers three ways to exit the system: 

• Select File > Exit to exit CDMS (Figure 2-4). 

• Select the Exit CDMS button. 

• Select the X button in the upper right of the application. 

Figure 2-4: File Menu 
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2.1.2 Tools Menu 

The Tools menu contains system actions and options (Figure 2-5): 

• Specify Hazus Data Location. 

• Package Statewide Hazus Data. 

• Clear Statewide Modification History. 

Figure 2-5: Tool Menu 

 

2.1.3 Specify Hazus Data Location 

The first time CDMS is launched, the system will not have a specified Hazus state dataset. If a 

state has been specified, it will appear in the Current State area on the left side of the CDMS 

Home screen. If no state has been specified, a label will appear and will state “Please Select 

Hazus Statewide Data Location.” Hazus organizes data on a state-by-state basis. CDMS will 

only work with one Hazus state dataset at once. Select the Tools option and then select 

Specify Hazus Data Location. A new form will open and ask the user to specify a statewide 

database folder, as shown in Figure 2-6. Connect to a folder by entering the folder name or by 

clicking the Browse button, choosing the folder, and clicking the OK button. 

Figure 2-6: Statewide Database 
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CDMS will inspect the selected directory to verify that the state database is valid. When the 

system has completed the verifications, the state name for the specified directory will appear 

under Current State on the left side of the CDMS Home screen (Figure 2-7). 

Figure 2-7: Current State 

 

Now modifications can be performed on the Hazus state data. CDMS will retain the connection 

to the selected state data location until the data path points to another state data folder. 

2.1.4 Package Statewide Hazus Data 

Hazus state datasets can be packaged in a zip file format for easy distribution to other users or 

for backup. Users can only package the state specified in Current State. 

To package statewide data files, select Tools from the menu at the top of the screen and select 

Package Statewide Hazus Data (Figure 2-8). 

Figure 2-8: Package Statewide Hazus Data 

 

A new window will appear in which a zip file name (Figure 2-9) must be entered. Enter the name 

of the zip file and specify the folder in which it will be saved. Click the Save button and the 

window will close. The data will be saved to the specified folder, and a confirmation message 

will appear. 
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Figure 2-9: Package State Data File Window 

 

2.1.5 Clear Statewide Layer Modification History 

CDMS tracks the history of updates made to Hazus state datasets. As data are updated in 

CDMS and transferred to Hazus statewide datasets, a log will be available from the CDMS 

Home screen under the title Statewide Layer Modification History. This history is kept until 

the statewide data location is changed or the Clear Statewide Modification History menu item 

is used to remove it. The CDMS Home screen will refresh with all of the data removed from the 

page. 

To clear the statewide modification history, select Tools from the menu at the top of the screen 

and select Clear Statewide Modification History (Figure 2-10). Clearing the Statewide 

Modification History is required for the user to change from one state to another. Clearing the 

history does not delete any data the user has updated for their current state. It simply removes 

the entries from the history so a new state can be worked on. 

Figure 2-10: Clear Statewide Modification History 
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2.1.6 Help Menu 

CDMS provides an online help menu with information that is provided in this document to help 

with navigating through and performing data update operations. 

To access the Help system, select Help > Contents (Figure 2-11). 

Figure 2-11: Help Menu 
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3 Importing Site-Specific Inventory Data 

The accuracy of the Hazus-provided default site-specific inventory varies considerably by 

category and state. Site-specific inventory data originated from a multitude of national sources. 

The vintage of each dataset is provided in accompanying metadata files inside each Study 

Region. The CDMS Data Dictionary is a valuable resource because it can demonstrate how to 

update state databases. The import function of CDMS allows inventory data to be imported, 

validated, and converted into a format that can be merged into Hazus state datasets. 

Site-specific facilities that Hazus analyzes vary with each model. For example, bridges are 

analyzed in the earthquake model but not the hurricane model. The variations by model can 

help determine how to prioritize the inventory categories that need to be updated for each 

model. There is considerable interest in modeling buildings in Hazus. The most common 

workflow uses building locations that have been clipped to the hazard boundaries (e.g., 500-

year flood boundary). These flood-prone buildings are imported into Hazus as UDFs. A UDF is a 

type of site-specific data. Very few UDF records come with Hazus, although starting with Hazus 

version 4.2, partially developed UDF data can be imported and CDMS will populate the 

remaining attributes with default values based on user-supplied building square footage and 

occupancy class. User-supplied data can be collected, classified, and imported into a Hazus 

state dataset using CDMS.  More specific information can be located in the Hazus Earthquake 

User Manual and/or the Hazus Earthquake Technical Manual.  

Site-specific inventory data should be imported when updating individual records such as 

Essential Facilities, High Potential Loss Facilities, and UDFs. For earthquake analysis, AEBM 

information with occupancy type, earthquake building type, and earthquake design level can 

also be imported. 

The workflow for importing site-specific inventory is: 

• Select a source data file. 

• Specify the destination category. 

• Define source data parameters. 

• Match fields. 

• Identify validation issues. 

• Categorize data. 

• View the results in the CDMS Repository. 

3.1 Selecting a Source Data File 

From the CDMS Home screen: 

• Click the Import into CDMS Repository from File button (Figure 3-1). 

• Specify a source file by clicking the Browse button and selecting a source file 

(Figure 3-2). 

• Click the Open button to import the file (Figure 3-3). 
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Figure 3-1: Repository Import 

 

 

Figure 3-2: File Import into Repository 
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Figure 3-3: Open File to Import into Repository 

 

One or more hazards also need to be selected by clicking the check box (or boxes) under the 

file path, as shown Figure 3-4, to limit updates to partial information for a dataset. Based on the 

hazards that are selected, additional hazard-specific structure vulnerability attributes are 

needed. By default, all three hazards are selected, but one or more can be deselected before 

continuing.  

Figure 3-4: Select Hazard for Import Data 

 

3.2 Specifying the Destination Category 

A destination must be specified for each imported file. The destination is determined according 

to which inventory category and dataset are selected (Figure 3-5). 
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To import site-specific inventory data, a site-specific inventory category (e.g., Essential 

Facilities, Transportation Systems) must be selected: 

• Select a category from the Select Hazus Inventory Category dropdown list. 

• Select a dataset from the Select Hazus Inventory Dataset (Layer) drop down list. 

• Click Continue at the bottom of the screen to move to the next page. 

Figure 3-5: Select Inventory Category 

 

NOTE: Use the Back button to go back and update information as needed. Also use the CDMS 
Home button to navigate back to the primary navigation screen as needed. 

3.3 User-Defined Facilities Data Import 

To launch CDMS from the Windows Start button, choose All Programs > FEMA Risk 

Assessment System > CDMS or double click the desktop icon. Set the Current State using 

Tools > Specify Hazus Data Location (Figure 3-6). 
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Figure 3-6: Set the Current State 

 

Click Import into CDMS Repository from File (Figure 3-7). 
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Figure 3-7: Selection of CDMS Repository from File into CDMS 

 

The Import into CDMS Repository window will appear (Figure 3-8). The default data type is 

Point. Click the Line radio button if needed to change the data type. Click the Browse button to 

select the database that contains the UDF feature class. The data format must be MS Access 

.mdb, MS Excel .xls, or Esri Shapefile .shp. The default Hazus Inventory Category will be User-

Defined Facilities as will the default Hazus Inventory Dataset. Please note the minimum 

required fields (Area [Sq feet] and Occupancy) before attempting to import data. Including 

additional fields with local data will omit the populating of default values and result in more 

accurate model results.   
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Figure 3-8: Import CDMS Repository File 

 

On the next screen (Figure 3-9), select the UDF feature class from the Select Import Table 

dropdown. If a unique field in the feature class is needed, that field can be selected from the 

Select Hazus-ID Field dropdown. Otherwise, use the No HAZUS ID option and CDMS will 

insert a unique value. Click Continue. If the data have not been projected to WGS84, an error 

message may appear. 
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Figure 3-9: Selection of File to Import 

 

CDMS will automatically map fields that have the same name in the source and destination 

tables (Figure 3-10). The remaining fields must be mapped. Fields shown in red text in the 

destination table are required and must be supplied by the user. If the fields in green are not 

supplied by the user, CDMS will enter standard Hazus default values. Typically, the more data 

the user supplies, the more accurate the resulting dataset. To map the fields, select a value in 

the source and destination tables and click Add Match. Once the field mapping process is 

complete, click the Save button. If a mapping scheme has already been saved, it can be used 

by clicking the Load button. All mappings will be moved to the Field Matches table. Click 

Continue when finished. 
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Figure 3-10: Data Field Matching 

 

A message box will appear (Figure 3-11) indicating which fields were not supplied with user data 

and as a result will be populated with default values. Click Yes to continue. 

Figure 3-11: CDMS Default Value Validation 
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A Categorize Fields message will appear (Figure 3-12). Some of the fields that were supplied 

with data will need to be categorized into Hazus-specific data. If the data that have been 

imported already use Hazus-compatible attributes, the categorization will be automatic. Click 

OK to continue. 

Figure 3-12: Message Box for Missing Fields 
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A Category Value Matching window will appear (Figure 3-13). To categorize the data, select a 

value from the Source box and then select the corresponding value in the Destination table. 

Click Add Match. When all fields are categorized, click Continue. 

Figure 3-13: CDMS Back-Up Category Value Matching 
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In the example shown in Figure 3-14, the values in the import feature class were already 

attributed to meet the Hazus requirements for Flood Foundation Type. The field box in 

Figure 3-14 is empty, indicating that CDMS could move the attributes to the matching result box. 

Click Continue when done. 

Figure 3-14: CDMS Flood Foundation Type Value Matching 

 

 

When the mapping process is complete, CDMS will check all of the data that are to be imported. 

If any errors are discovered, an error message will appear (Figure 3-15) indicating which data 

need to be corrected to continue. Click OK. 

Figure 3-15: CDMS Import Data Error 
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CDMS will generate an Error Report if CDMS detects an error in the data. The Error Report, 

shown in Figure 3-16, will help determine the errors. Once all of the errors have been resolved 

through data validation, the import process can continue. 

Figure 3-16: CDMS Validation Error Report 

 

 

 

Figure 3-17: CDMS Data Import Success 



 

Hazus CDMS User Guidance  Page 3-14 

Once the import process is complete, CDMS will return to the CDMS Home screen and the 

newly imported UDF layer will be listed in the CDMS Repository (Figure 3-18). To use the UDF 

layer in a Hazus region, it will need to be transferred to a state database. The transfer process 

is discussed in Section 10. 

Figure 3-18: CDMS Repository Data View 

 

3.4 Developing UDF Data 

The methods used to create UDF data can vary from person to person and depend on the type 

of data and on the format that users are provided. The following is a high-level overview of how 

UDF data can be created. 

NOTE: With the release of CDMS 4.2, the only values that the user must provide are building 
area and occupancy type. 

Users often use tabular data from a city or county tax assessor’s office, in addition to a separate 

spatial dataset that can be either address points or parcels, when creating UDF data. The 

assessor’s data typically contain many useful data points, such as parcel ID, occupancy, 

building area, year built, building cost, number of stories, and construction type. The address or 

parcel data may have a few fields, but the most useful field, parcel ID, can be used to join the 

two datasets. 
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3.4.1 UDF Data Creation Steps 

To create UDF data: 

1. Obtain data containing tabular building information and spatial location. 

2. Review data to gain an understanding of the contents. 

3. Join tabular data to the spatial location data using a common field, often parcel ID. 

4. It can be helpful to add the fields from Table 3-1 after performing the join. This will make 

the field mapping in CDMS go more smoothly. 

5. Transfer the values from the supplied data to the newly created fields. At a minimum, the 

user must supply occupancy type and building area. If the area is not provided and the 

spatial data are building footprints, the area may be obtained by using the area of the 

footprint. 

6. Follow the CDMS UDF import process described in Section 3.3. 

Table 3-1: Sample CDMS Data Schema 

Field Name Type Size* Field Name Type Size* 

CONTACT Text 40 LONGITUDE Double 16 

NAME Text 40 COMMENT Text 40 

ADDRESS Text 40 CONTENTCOST Float 8 

CITY Text 40 DESIGNLEVEL Text 1 

STATE Text 2 FOUNDATIONTYPE Text 1 

ZIPCODE Text 40 FIRSTFLOORHT Double 8 

PHONENUMBER Text 47 SHELTERCAPACITY Short 2 

OCCUPANCY Text 5 BLDGDAMAGEFNID Text 10 

YEARBUILD Short 2 CONTDAMAGEFNID Text 10 

COST Float 8 INVDAMAGEFNID Text 10 

BACKUPPOWER Text 1 FLOODPROTECTION Long 4 

NUMSTORIES Short 1 SOILTYPE Text 5 

AREA Float 4 LQFSUSCAT Short  

BLDGTYPE Text 15 LNDSUSCAT Short  

LATITUDE Double 16 WATERDEPTH Double  

*Size is based on type: text – character amount; numbers (float, double, short) – number of digits in the value 

Figure 3-19 displays some of the records from a sample import. Notice that the Building 

Replacement Value column is populated even though these values were not included in the 

import table. CDMS is able to attribute some fields by deriving the value from other attributed 

fields based on some default Hazus calculations. 
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Figure 3-19: Sample Output After Import 

 

3.5 Defining Source Data Parameters 

After specifying the file location, inventory category, and inventory dataset, parameters for the 

source data must be defined before the system can import the file. Options for the source data 

parameters depend on what type of file is chosen for import. If an Esri personal geodatabase or 

an Esri shapefile is chosen, the only parameter that can be chosen is the Hazus ID. Otherwise, 

the Latitude and Longitude fields must be specified in the data. 

NOTE: All Hazus default inventory data are projected to WGS84. Please ensure that all user 
input data for CDMS are in the same coordinate system. 

CDMS will automatically select the import table for the data if the data are provided as an Esri 

shapefile. With other data types, such as MS Excel or MS Access, many worksheets or data 

tables may exist. Select the correct source import table from the Select Import Table dropdown 

and continue to the Select HAZUS-ID Field as shown in Figure 3-20. The HAZUS-ID field is 

very important to CDMS. This field is used by the system to match records being uploaded to 

existing records in the Hazus state datasets. If there is no HAZUS-ID field, select the No 

HAZUS-ID option in the dropdown. For the No HAZUS-ID option, all records will be treated as 

new information and will be added to the statewide Hazus datasets. Once the parameters have 

been defined, click Continue. 
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Figure 3-20: Define Source Data Parameters 

 

3.6 Matching Fields 

CDMS requires the user to match the import data file source fields to the fields that reside in the 

Hazus data. The Data Field Matching screen shown in Figure 3-21 allows this to occur. 

The Source Fields box on the left lists fields from the source file. The Destination Fields box 

on the right lists the fields in the Hazus data. The system will automatically match the fields that 

have the same name and same characteristics. Auto-matches need to be verified and need to 

match the remaining fields, if applicable. 

To add the field matches to the Field Match list at the bottom of the screen, select one field 

from the Source Fields box and its match from the Destination Fields box. Click the Add 

Match button as shown in Figure 3-21.  

Fields with red text:  

• Required.  

• Must be matched before continuing.  

Fields with green text: 
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• Required. 

• If a field cannot be matched, a default value is inserted. 

•  Values may differ from the original state inventory data default values.  

•  Carefully review each value.  

•  In some cases, default placeholders may be used. 

Refer to the CDMS Data Dictionary for additional information on where these fields are used in 

Hazus. Once all known matches have been made, the import process can continue. 

Figure 3-21: Field Matching 

 

To the right of the list of Field Matches are three buttons: Load, Save, and Remove. Click the 

Load button to use a saved set of field matches for similar data. A window will appear, and the 

file to import must be selected. Once a file has been selected, the data will be loaded into the 

system, and the data will be seen in the Field Matches list. A file that was saved with the same 

category and dataset must be selected; otherwise, the data will not be valid and the user will get 

an error message. 
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To save a list of field matches, click the Save button and then specify a file name. Once the list 

is saved, it can be used with another file that has the same category and dataset. 

If a match needs to be removed from the list, select the match and click the Remove button. 

Once all known fields have been matched, click the Continue button to continue the import 

process. 

3.7 Validation Issues 

When data are imported into the CDMS, the data are validated. The validation process confirms 

that the imported data match the CDMS requirements and ensures that all required fields have 

a value and the fields match correctly. If any data fail validation, CDMS will generate an error 

report (Figure 3-22) identifying the validation errors. Correction of all validation errors and 

re-validation of the data must be completed before the file can be imported properly. 

Figure 3-22: Matching Field Validation 

 

 

3.8 Data Categorization 

After all fields have been matched for a source file being imported, some fields may need to be 

categorized into Hazus-specific data. Once the data have been imported, a window will appear 

with the list of fields that require categorization. 

Click OK to continue. 

Figure 3-23: Data Categorization 
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A Category Value Matching window (Figure 3-24) will appear for each separate field 

categorization. The categorization window will be in the same format as the Data Field 

Matching screen (Figure 3-21). Select a field from the Source box on the left and a 

corresponding field from the Destination box on the right. Click the Add Match button 

(Figure 3-24). Once the field has been matched, click the Continue button. 

Figure 3-24: Category Value Matching 

 

Follow the same steps for each field requiring categorization. Once all fields have been 

categorized, a window will appear stating that the data were imported successfully 

(Figure 3-25). Click OK. When the import process completes, the system will return to the 

CDMS Home screen, and the new data will be listed in the CDMS Repository. 

Figure 3-25: Data Import Success 

 

3.9 Viewing the Results in the CDMS Repository 

Once data have been imported into CDMS, the dataset will be listed in the CDMS Repository 

on the CDMS Home screen (Figure 3-26). The Category, Layer, Records Affected, Upload 

Date and Upload By columns will be shown. To view individual data layers, click the View 

button on the left. To remove individual data layers, click the Remove button. 
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Figure 3-26: Result View 
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4 Importing and Aggregating General Building Stock Data 

This section describes how data may be imported into the CDMS Repository and summarized 

to provide aggregated data to Hazus statewide datasets. 

The three possible inputs for generating aggregated data are: 

• Providing pre-aggregated data from a file. 

• Importing site-specific data to aggregated data. 

• Utilizing information in the existing building-specific data area within CDMS. 

4.1 Providing Pre-aggregated Data from a File 

A file with information that has already been aggregated at the census block or tract level may 

be provided, and the system can provide a straight conversion into existing Hazus aggregate 

tables. 

The tables that may be updated are: 

• Agriculture Inventory by County Federal Information Processing Standards (FIPS). 

• Building Counts by Census Block/Tract. 

• Building Square Footage by Census Block/Tract. 

• Demographics by Census Block/Tract. 

• Exposure Content by Census Block/Tract. 

• Structure Exposure by Census Block/Tract. 

• Vehicles – Day Inventory by Census Block. 

• Vehicles – Night Inventory by Census Block. 

NOTE: Providing pre-aggregated data from a file is ideal when users have maintained their data 
at the census block or tract level. 

If users already have pre-aggregated data, users can convert their data to the CDMS 

Repository with minimal effort using the following steps: 

• Select Import into CDMS Repository from File in the CDMS Home screen (Figure 4-1). 

• Select the Browse button to find a file for data import (Figure 4-1). 

• Select the Open button (Figure 4-2) and the folder path will appear in the indicated area 

on the screen (Figure 4-1). The user must also choose one or more hazards using the 

check boxes under the file path (Figure 4-1). If state is a Hurricane Region state, all three 

hazards will automatically be selected since aggregated data do not depend on hazard-

specific information. 

• Move down to the Select Hazus Inventory Category (Figure 4-1 and Figure 4-2). 



 

Hazus CDMS User Guidance  Page 4-2 

Figure 4-1: Select Import into Repository from File 
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Figure 4-2: Open File in Repository 

 

4.1.1 Specifying the Destination 

Ensuring that specific data are attributed to a certain inventory category, the user must specify 

the destination of the dataset, as follows: 

• Select Aggregated Data from the Select Hazus Inventory Category dropdown list 

(Figure 4-3). 

• Select an Inventory Dataset from the Select Hazus Inventory Dataset dropdown list 

(Figure 4-3). 

• Required Fields, if any, will be listed in the lower right of the screen. Select the Continue 

button to continue with the import process (Figure 4-3). 



 

Hazus CDMS User Guidance  Page 4-4 

Figure 4-3: Specifying the Destination of Data 

 

4.1.2 Selecting the Import Table 

If the user imports a shapefile, the Import Table will be selected automatically. If an MS Access 

or Excel File is chosen, the user will have a choice of worksheets or tables to use for the import 

process. 

• Select the Import Table from the dropdown list (Figure 4-4). 

• Select the Continue button (Figure 4-4). 
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Figure 4-4: Select Import Table 

 

4.1.3 Matching Fields 

Because data are distributed in the Hazus database by occupancy type (e.g., RES1 [Single 

Family Dwelling], RES2, [Mobile Home] COM1 [Retail Trade], COM2 [Wholesale Trade]), the 

user must provide field matching to make sure that the source/destination field pairs are correct. 

The Field Matches section of Figure 4-5 has a source list on the left with a list of fields from the 

source file and a destination list on the right that lists the fields that are in the Hazus database. 

The system automatically matches fields with the same name and same characteristics. The 

user must match the rest of the fields by selecting one field from the source list and its match 

from the destination list (Figure 4-5). 
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Figure 4-5: Matching Fields Import 

 

After selecting a field from both lists, add the field’s matches to the list at the bottom of the 

screen by selecting the Add Match button.  

Fields with red text:  

• Required. 

• Must be matched before continuing.  

Fields with green text: 

• Required 

• If a field cannot be matched, a default value will be provided  

Once all known matches have been made, the user can continue the import process as follows: 

• Select Source Field. 

• Select Destination Field. 

• Select Add Match button. 
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The Load, Save and Remove buttons, are right of the list of field matches (Figure 4-5). The 

Load button is used if there is a saved set of field matches the user wants to load into the 

system to use for the chosen data. Once the Load button has been selected, a new window will 

appear, and the user will need to select a file to import. Once a file has been chosen, the data 

will be loaded into the system, and the file will appear in the list of field matches. When loading 

the file, the user must choose a file that was saved with the same category and dataset. 

Otherwise, the data will not be valid, and the user will get an alert message. 

The Save button is used to save a list of field matches. The user must give the list a file name. 

Once the list is saved, it can be used with another file that has the same category and dataset. 

The Remove button is used to remove match from the list for any reason. The user selects the 

match and then selects the Remove button. 

Once all known fields have been matched, the user must select the Continue button to continue 

with the import process (Figure 4-5). 

4.1.4 Validating Data 

When data are imported into CDMS, a validation process ensures that all required fields have a 

value and that the fields match correctly. If any data fail validation, a report showing the 

validation errors if any will appear (Figure 4-6). If a validation error occurs, the user must fix the 

error before the file can be imported properly. 

Figure 4-6: Matching Field Import Data Validation 

 

4.1.5 Viewing the Results in the CDMS Repository 

Once data have been imported into CDMS, the data will appear in the CDMS Repository on 

the CDMS Home screen (Figure 4-7). The Category, Layer, Records Affected, Upload Date, 

and Upload By columns will be shown on the CDMS Home screen. To see individual data 

layers, select the View/Edit button. 
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Figure 4-7: View Results in the Repository 

 

4.1.6 Importing Site-Specific Data to Aggregated Data 

Users may want to import information in one or more of the following file formats: Esri shapefile, 

Esri personal geodatabase, MS Access, and MS Excel. When the user specifies the path for the 

input file, the system will navigate the user through the field mapping and categorization process 

and validate the data according to Hazus field data types. 

Transfer the data into the CDMS Repository tables as follows: 

• Building Counts by Census Block/Tract. 

• Building Square Footage by Census Block/Tract. 

• Structure Exposure by Census Block/Tract. 

• Exposure Content by Census Block/Tract. 

NOTE: Importing site-specific data to aggregated data is ideal when users have a 
building/parcel file with necessary structural and hazard data. 

4.1.7 Utilizing Information in the Existing Building-Specific Data Area in CDMS 

The utilizing information in the existing building-specific data area in CDMS function 

allows users to export data from their building-specific data and import the data into the 

repository using the Importing Site-Specific Data to Aggregate Data function. CDMS will 
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perform field mapping, categorization, and validation before placing aggregated data into the 

CDMS Repository. 

NOTE: The utilization information in the existing building-specific data CDMS function is ideal 
when users have a building/parcel file without necessary structural and hazard data. The user 
may import information into building-specific data, update structural and hazard data, and then 
aggregate the data. 

4.2 Providing Building/Parcel Data from a File 

It is important to note that the user can increase the accuracy of Hazus information by providing 

building- or parcel-specific data. The user can incorporate the data using a source data file. 

4.2.1 Selecting a Source Data File 

To select a source data file, take the following steps in the CDMS Home screen: 

• Select Import into CDMS Repository from File (Figure 4-8). 

• Select the Browse button to find a source data file. 

• Select the Open button (Figure 4-9) and the folder path will appear in the indicated area 

on the screen (Figure 4-8). The user may also choose one or more hazards using the 

check boxes under the file path. 
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Figure 4-8: Select Source Data File 
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Figure 4-9: Open Source Data 

 

4.2.2 Specifying the Destination 

To ensure that data are imported into CDMS correctly, the user must specify the destination of 

the data file, as follows: 

• Select Aggregated Data from the Select Hazus Inventory Category dropdown list 

(Figure 4-10). 

• Select the Import Site-Specific Data to Aggregate Data button. 

• Review the Required Fields that are listed to make sure the information is in the data files. 

• Select the Continue button. 
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Figure 4-10: Data Destination 

 

If aggregate data are already in the CDMS Repository, a warning message will appear telling 

the user that any existing data in the CDMS Repository will be replaced with the new data 

(Figure 4-11). The user should transfer any existing aggregated data to the statewide Hazus 

database before continuing. The user must choose the Yes button to continue with the import 

process or No to cancel the process. 

Figure 4-11: Repository Replacement Notification 

 

Once Yes option is chosen, the window shown in Figure 4-12 will appear. In the window, the 

user must select an input table. If a user imports a shapefile, the Import Table will be selected 
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automatically. In the Import Building Data screen, the user must select the table the user wants 

to import into CDMS. If an MS Access or Excel File is chosen, the user will have a choice of 

worksheets or tables to use for the import process. 

Figure 4-12: Import Building Data 

 

4.2.3 Matching Fields 

The CDMS Home screen will have a source list on the left with a list of fields from the source 

file and a destination list on the right that lists the fields that are in the Hazus database 

(Figure 4-13). The system will automatically match the fields with the same name and same 

characteristics. The user must match the rest of the fields by selecting one field from the source 

list and its match from the destination list. 

After selecting a field from both lists, add the field’s matches to the list at the bottom of the 

screen by selecting the Add Match button (Figure 4-13).  

Fields with red text:  

• Required.  

• Must be matched before continuing. 

Fields with green text: 

• Required. 
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• If a field cannot be matched, a default value will be provided.  

Once all known matches have been made, the user can continue the import process, as follows: 

• Select Source Field. 

• Select Destination Field. 

• Select Add Match button. 

Fields are also color coded according to the groupings of information required for the 

aggregation process (Figure 4-13). The user must supply at least one field in each color 

grouping (e.g., Building Quality and Age and Year of Construction are in purple; the user 

must provide at least one of these fields to continue). 

Figure 4-13: Building Data Matching Files 

 

The Load, Save and Remove buttons, are right of the list of field matches (Figure 4-13). The 

Load button is used if there is a saved set of field matches the user wants to load into the 

system to use for the chosen data. Once the Load button has been selected, a new window will 

appear, and the user will need to select a file to import. Once a file has been chosen, the data 

will be loaded into the system, and the file will appear in the list of field Matches. When loading 
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the file, the user must choose a file that was saved with the same category and dataset. 

Otherwise, the data will not be valid, and the user will get an alert message. 

The Save button is used to save a list of field matches. The user must give the list a file name. 

Once the list is saved, it can be used with another file that has the same category and dataset. 

The Remove button is used to remove a match from the list for any reason. The user selects 

the match and then selects the Remove button. 

Once all known fields have been matched, the user must select the Continue button to continue 

the import process (Figure 4-13). 

4.2.4 Validating Data 

When data are imported into CDMS, a validation process ensures that all required fields have a 

value and that the fields match correctly. If any data fail validation, a report showing the 

validation errors will appear (Figure 4-14). If a validation error occurs, the user must fix the error 

before the file can be imported properly. 

Figure 4-14: Building Data Validation 

 

4.2.5 Categorizing Data 

After the fields for the data being imported have been matched, some fields may need to be 

categorized into Hazus-specific data. The window shown in Figure 4-15 will appear and will 

have a list of fields that need to be categorized. Select the OK button to continue with the 

categorization process. 
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Figure 4-15: Data Categorization 

 

Part of the categorization process is converting data in source fields to Hazus-required values. 

For Area, Building Value, Contents Value, Number of Stories, and Year Built, the conversion 

screen will ask the user to verify the format of the data. The Area Field Type (area conversion) 

screen is shown in Figure 4-16. 

Figure 4-16: Area Field Type 
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For Area, Building Type, and Occupancy Class, a window will appear for value categorization 

(Figure 4-17). The categorization window is in the same format as the field matching screen. 

The user will choose a value from the source list and a value from the destination list and select 

the Add Match button. Once each value on the screen has been matched, the user will select 

the Continue button. 

Figure 4-17: Building Category Matching 

 

The next field categorization screen will appear, and the user will follow the same steps as in the 

previous window. The user will continue until all fields have been categorized. At that point, a 

final screen will appear and will allow the user to make choices regarding the General Building 

Type Mapping schemes (Figure 4-18). 

The default choice uses system defaults for any occupancy categories the user does not 

provide. Another choice now allows users to use the most recent General Building Type 

mapping scheme values for defaults. Making this choice will only update the default data in the 

provided occupancy categories and simulate no change in the non-provided occupancy 

categories. 
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Figure 4-18: General Building Type Mapping Scheme Options 

 

4.2.6 Viewing the Results in the CDMS Repository 

After aggregated data have been processed, the data will appear in the CDMS Repository on 

the CDMS Home screen (Figure 4-19). The Category, Layer, Records Affected, Upload 

Date, and Upload By columns will be shown on the CDMS Home screen. To see individual 

data layers, select the View/Edit button. 

Figure 4-19: Viewing Repository Results 
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4.2.7 Aggregating Building-Specific Data 

Building-specific data are data that are created and/or modified in CDMS as follows: 

• From the Building-Specific Data screen, select the Export Table button. To aggregate the 

data, reimport the data into CDMS by clicking on the Importing Site-Specific Data to 

Aggregate Data button. 

Figure 4-20: Importing Site-Specific Data to Aggregate Data 

 

 

 

• When this message appears, click Yes. 
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• Select the input table in the following dialog and then match the fields to import the table. 

 

Figure 4-21: Input Table Selection 
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5 Importing into the CDMS Repository from a Hazus Study Region 

CDMS can connect to a Hazus Study Region and import data from that Study Region into the 

statewide Hazus dataset. This is especially useful if the user has added new features to his or 

her Study Regions and would like to merge the features with the state data. 

• Select the Import into CDMS Repository from Hazus Study Region button in the 

CDMS Home screen (Figure 5-1). 

Figure 5-1: Import Hazus Study Region 

 

When the Study Region import screen opens: 

• Select a Study Region from the dropdown list (Figure 5-2). Study Region Hazards will 

show which hazards were selected for the Study Region 

• Select a Study Region Inventory Category from the dropdown list (e.g., Essential 

Facilities). 

• Select the Study Region Inventory Category Datasets from the listing and use the 

arrow buttons to move them to the Selected Study Regions listing. 

• Select the Continue button at the bottom of the screen to move to the next screen. 
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Figure 5-2: Study Region Inventory Category Datasets 

 

A window will appear with a list of the data layers chosen by the user. Select the Import button 

to finish the import process (Figure 5-3). When the data have finished importing, a message will 

appear in the Import Status column letting the user know that the import is complete. When all 

data layers have been imported, the Done button in the bottom right corner of the screen will 

become active and can be selected. 
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Figure 5-3: CDMS Import Status 
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6 Building-Specific Data 

Building-specific data can be entered manually or imported via site-specific import routines. This 

function is useful when data need to be refined before aggregation. 

The following actions are described in Chapter 6: 

• Adding a New Building. 

• Editing or Deleting an Existing Building. 

• Exporting Building-Specific Data. 

• Searching Building-Specific Data. 

6.1 Adding a New Building 

To add a new building, first select the Building-Specific Data button on the left in the CDMS 

Home screen (Figure 6-1). 

Figure 6-1: Adding a New Building 

 

The screen that appears will have four tabs at the top of the screen: General, Earthquake, 

Flood, and Hurricane (Figure 6-2). Each tab contains subtabs with detailed information for the 
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main tab. Select the Add new  button at the bottom of the screen to add a new building record 

(Figure 6-2). 

Figure 6-2: Building a New Record 

 

• A window will appear. Enter a building identifier, select a building facility type from the 

dropdown list, and then select the OK button (Figure 6-3). 

• The window will close, and the new building will be shown on the screen. Edit the current 

information for the building if needed and save it. 
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Figure 6-3: Add New Building 

 

6.2 Editing or Deleting an Existing Building 

To edit an existing building in the Building-Specific Data section: 

• Select the Building-Specific Data button from the menu on the left side of the CDMS 

Home screen (Figure 6-4). 

• Select a different building using the left and right arrows. 

• Select the Save button when information has changed for a building. 

• Select the Delete button to remove the current record. 

The new or changed information will be saved in the system and available for modification or 

deletion if necessary. 
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Figure 6-4: Editing or Deleting an Existing Building 

 

*Items in green are required for aggregation activities  

 

6.3 Exporting Building-Specific Data 

Once the user has navigated to the building-specific data screen using the Building-Specific 

Data button on the CDMS Home screen, the user can view the building-specific data that are 

saved in the system (Figure 6-5). Data must be input into the forms to be able to export the 

data. Select the Export Table button on the left side of the screen. 
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Figure 6-5: Exporting Building-Specific Data 

 

A new window will appear, and the user must select the criteria to export. All fields are selected 

by default. By default, the export will be to an MS Access database, but data may also be 

exported to Excel by changing the radio button option at the bottom of the screen (Figure 6-6). 
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Figure 6-6: CDMS Building Export Parameter Definition 

 

Once the criteria are chosen, select the Export button and a Save File window will appear. 

Select the folder where the data are to be saved and select the Save button. The window will 

disappear, and a message box will be displayed confirming export completion. To close the 

criteria window, select Cancel or use the Close button in the top right corner of the screen. 

6.4 Searching Building-Specific Data 

While at the Building-Specific data screen, users can search for specific building information 

that is listed in the tables. To do this, select the Search Buildings button on the left side of the 

screen (Figure 6-7). 
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Figure 6-7: Building-Specific Search 

 

A new window will appear, and the user will see a list of existing buildings to choose from 

(Figure 6-8). 
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Figure 6-8: Building-Specific Data Search 

 

Once the building to edit has been found, select the Edit button. The building list window will 

disappear, and the user will see the building information for the selected building on the 

building-specific data screen. 
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7 Querying/Exporting Statewide Datasets 

If the user has specified a statewide Hazus data location, the data can be queried, deleted, and 

exported. The following actions are described in Chapter 7: 

• Searching Statewide Geodatabases. 

• Deleting Statewide Data. 

• Exporting Search Results to an MS Excel File. 

• Exporting Search Results to an Esri Personal Geodatabase. 

7.1 Searching Statewide Geodatabases 

To search statewide geodatabases, first select the Query/Export Statewide Datasets button 

on the left in the CDMS Home screen (Figure 7-1). 

Figure 7-1: Searching Statewide Geodatabases 

 

The Query/Export Statewide Datasets screen will appear (Figure 7-2). The user should 

specify the following information: 

• Geographic location 

− Statewide 
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− County (one or more may be selected) 

− Census Tract (one or more may be selected) 

− Census Block (one or more may be selected) 

• Category datasets such as: 

− Essential Facilities > Police Stations 

− Essential Facilities > Schools 

− High Potential Loss Facilities > Military Installations 

• Hazards (returns general inventory fields plus selected hazard data): 

− Flood 

− Earthquake 

− Hurricane wind 

− Tsunami 

Use the arrow buttons to move information to the Selected Geographical Areas and Selected 

Data Layers boxes. After the necessary information has been selected, press the Search 

button. 
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Figure 7-2: Query/Export Statewide Datasets 

 

The system will query statewide Hazus datasets and prepare the information in the following 

screen (Figure 7-3). 

The search summary will display the geographic search criteria. The search results will display 

individual datasets in a dropdown menu along with a record count of the number of features 

returned. The user can use the dropdown list to switch between datasets (Figure 7-3). 
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Figure 7-3: Statewide Datasets Search 

 

7.2 Deleting Statewide Data 

To delete inventory information from a statewide Hazus dataset, first query the data using the 

techniques that are described. On the search results screen (Figure 7-4), select the Delete 

button to remove individual records from statewide Hazus datasets. To remove all of the records 

that are selected, press the Delete All Records for Selected Inventory button. In either case, 

a request to verify the removal of the data will appear. 

7.3 Exporting Search Results to an MS Excel File 

The data that are shown in the search results list can be exported to MS Excel or an Esri 

personal geodatabase. To export the data to MS Excel, select the Export to MS Excel button 

(Figure 7-4). 
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Figure 7-4: Exporting Search Results 

 

 

The user must specify an option to export only the selected layer or all layers and then select 

the Submit button (Figure 7-5). 

Figure 7-5: Exporting Options 
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Enter a file name and choose a folder to save the data in (Figure 7-6). To save the file, select 

the Save button. The window will close and the queried list will be visible again. 

Figure 7-6: Saving Exported Data 

 

7.4 Exporting Search Results to an Esri Personal Geodatabase 

To export the search results to an Esri personal geodatabase, select the Export to 

Geodatabase button (Figure 7-7). 
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Figure 7-7: Exporting Search Results to an Esri Personal Geodatabase 

 

 

As with the MS Excel option, the user must make an export choice and select the Submit 

button (Figure 7-8). 

Figure 7-8: Exporting Selected Results to an Esri Personal Geodatabase 
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A new window will appear, and the user must enter a file name and choose a folder to save the 

data in. To save the file, select the Save button (Figure 7-9). The window will close, and the 

queried list will be visible again (Figure 7-10). The data can now be loaded into ArcGIS. 

Figure 7-9: Saving Results to an ESRI Personal Geodatabase 

 

Figure 7-10: Saving Geodatabases 
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8 Updating a Study Region with Hazus Data 

CDMS allows users to update an existing Study Region with user data. To do this, the user must 

select the Update Study Region with Hazus Data button (Figure 8-1). 

Figure 8-1: Update Study Region with Hazus Data 

 

The criteria screen will appear, and the user will need to select all of the criteria pertaining to the 

information that needs to be updated (Figure 8-2). 
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Figure 8-2: Update Study Region Criteria 

 

Once the criteria have been chosen, select the Continue button to move to the next screen 

(Figure 8-3). Select the Update button to initiate the process. The Update Status column will 

show the progress of each update. Once all of the updates are completed, the Done button will 

become available. Select the Done button to exit the update screen. 
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Figure 8-3: CDMS Study Region Update 
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9 CDMS Repository 

The CDMS Repository holds any data that have been imported and converted to Hazus data 

structures. Data shown in this window (Figure 9-1) have not been merged with Hazus state 

datasets. Any data shown in the repository can be viewed and removed by the user, and a 

report can be generated showing a summary of the data in the repository. 

Figure 9-1: CDMS Repository 

 

9.1 Viewing a Report of Data in the CDMS Repository 

To view a report of the data in the CDMS Repository, select the report icon  above the 

repository (Figure 9-1). A new window will appear with the data information for datasets in the 

CDMS Repository. The report can be printed and saved using the Print and Save buttons at 

the top of the report. 
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Figure 9-2: Viewing a Data Report 

 

9.2 Viewing Individual Records for a Site-Specific Inventory Dataset 

To see an individual record for a layer/dataset loaded into the CDMS Repository, select the 

View/Edit button (Figure 9-1) next to the layer of interest. A new window will appear with the 

detailed dataset information shown below. 

• Sort data by selecting on the column heading above the data. 

• Use the scroll bars to view all information available. 

When finished viewing, select the Close button in the bottom right corner of the screen, and the 

window will close. 

9.3 Removing Individual Records for a Site-Specific Inventory Dataset 

To view an individual record for a layer/dataset loaded into the CDMS Repository, select the 

View/Edit button (Figure 9-1) next to the layer of interest. 

A new window will appear with the detailed dataset information. Take the following actions as 

needed: 

• Sort data by selecting on the column heading above the data. 

• Use the scroll bars to view all information available. 

• Select the Remove button next to the inventory feature. This record will be removed and 

will not be available for transfer into the Hazus state dataset. 

The screen will refresh with the datasets deleted from the system. The user can delete another 

or close the window using the Close button in the bottom right corner (Figure 9-3). 
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Figure 9-3: Removing Individual Records 

 

9.4 Viewing Individual Records for an Aggregated Data Dataset 

Aggregated data imported into the CDMS Repository are listed under the category 

Aggregated Data (Figure 9-1). 

Select the View button to view the following information by census block and tract: 

• Building Counts 

• Square Footage 

• Content Exposure 

• Building Exposure 

A new window will appear with the dataset information shown in a list format (Figure 9-4). The 

data can be filtered using the dropdown list at the top of the screen. When finished viewing, 

select the Close button in the bottom right corner of the screen and the window will close. 
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Figure 9-4: Viewing Individual Records 

 

9.5 Removing a Site-Specific or Aggregate Dataset from the CDMS Repository 

Users may remove an entire dataset from the CDMS Repository. The user may want to do this 

because new information has been acquired or incorrect information has been uploaded. 

To remove a dataset from the CDMS Repository, select the Remove button next to the 

layer/dataset (Figure 9-5). 

Once the Remove button has been selected, the screen will refresh and the dataset will be 

deleted from the system. The user will not be able to transfer the removed dataset to a Hazus 

state dataset. 
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Figure 9-5: Removing a Site-Specific or Aggregate Dataset 
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10 Transferring Data into Hazus State Datasets 

Data residing in the CDMS Repository can be transferred into the Hazus state datasets for use 

within Hazus. Data residing within the CDMS Repository have already been validated to verify 

that the data meet the minimum Hazus data format requirements. 

NOTE: Data in the CDMS Repository have been verified for format and structure accuracy but 
not for geographic correctness. During the transfer process, CDMS will check to see that data 
being transferred will fit within census tracts for the given state. If any records are outside 
available census tracts, these records will be ignored. 

10.1 Transferring Site-Specific Inventory Data into Hazus State Datasets 

Site-specific inventory data in the CDMS Repository can be transferred to state datasets. The 

user must select a dataset by selecting the layer name and select the Transfer to Statewide 

Dataset button (Figure 10-1). 

Figure 10-1: Transferring Site-Specific Inventory Data 

 

CDMS will ask the user to specify an update strategy for data updates. The two primary options 

are: 

• Append/Update Data – This option should be used when importing a subset of data into 

a Hazus state dataset. The system will try to match the Hazus-ID to the user-specified ID. 

If a match is found, an update of record will take place. If a match is not found, a new 
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record will be added to the state dataset. To delete records from the state dataset, review 

the Query functionality. 

• Replace Data – This option should be used when a total replace of state data is needed. 

This option will remove all features residing in a Hazus state dataset for the selected layer. 

After the data transfer has completed, a window will appear stating that the dataset was 

transferred successfully. The dataset will appear in the Statewide Layer Modification History 

section of the CDMS Home screen. 

10.2 Transferring Aggregated Data into a Hazus State Dataset 

Aggregated data in the CDMS Repository on the CDMS Home screen can be transferred to 

statewide Hazus datasets. CDMS provides update routines to update aggregate information for 

the selected state. 

• Select the aggregated dataset layer from the CDMS Repository. 

• Select the Transfer to Statewide Geodatabase button. 

The window shown in Figure 10-2 will appear. The user should select the aggregate data layers 

the user wants to transfer. 

Figure 10-2: Transferring Aggregated Data 
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Select individual datasets or use the Select All button to select all datasets for update 

(Figure 10-2). To update the General Building Mapping schemes, select the appropriate check 

box. Select the tract/block processing options. By default, updates only occur on the 

tracts/blocks that are included in this update, but by checking Process all tracts/blocks in 

county, the user will receive the warning shown in Figure 10-3. 

Figure 10-3: Process All Tracts/Blocks in County 

 

If a user selects the option to process all county tract/blocks, a message will appear indicating 

the number of counties that will be affected by the update (Figure 10-4). The message is 

intended to prevent unintentional data updates. 

Figure 10-4: Number of Counties Affected 

 

Finally, if the user does not select the option to process all county tract/blocks, a message 

regarding occupancy count replacement will appear (Figure 10-5). The message gives the user 

the option to do a complete replacement of all occupancy counts from the input file or update 

only the non-zero counts. 
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Figure 10-5: Occupancy Replacement Options 

 

Select the Continue button to update a Hazus state dataset. 

Once the update routine has finished, the user will be notified that the data were transferred 

successfully, and the dataset will appear in the Statewide Layer Modification History. 
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11 Acronyms 

AEBM Advanced Engineering Building Module 

CDMS Comprehensive Data Management System 

COM1 Retail Trade 

COM2  Wholesale Trade 

FEMA Federal Emergency Management Agency 

FIPS Federal Information Processing Standards 

GBS General Building Stock 

GIS Geographic Information Systems 

MS Microsoft 

NIBS National Institute of Building Sciences 

NAD83  North American Datum of 1983 

RES1 Single Family Dwelling 

RES2 Mobile Home  

UDF User-Defined Facility 

WGS84 World Geodetic System 1984 
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12 Glossary 

Advanced Engineering Building Model (AEBM) structure: Procedures for earthquake 

analysis of individual buildings that are an extension of the general methods of the 

FEMA/National Institute of Building Sciences (NIBS) earthquake loss estimation methodology 

(Hazus) and provide damage and loss functions compatible with current Hazus software. 

Aggregation: Groups composed of multiple parts or numbers. 

Building: structure with a roof and walls 

Building contents (or contents): Furniture and equipment that is not integral to the structure, 

computers, or supplies. 

Building occupancy classes: Classification or categorization of structures based on usage. 

Census tract: Permanent statistical subdivisions of a county or jurisdictional entirety based on 

the Census Bureau’s Participant Statistical Areas Program. 

General Building Stock (GBS): Database that includes square footage by occupancy and 

building type, building count by occupancy and building type, validation by occupancy and 

building type, and general occupancy mapping. 

Hazard: Act or phenomenon that has the potential to produce harm or other undesirable 

consequences to a person or thing. 

Hazus. Geographic Information Systems (GIS)-based risk assessment methodology and 

software application created by FEMA and the NIBS for analyzing potential losses from floods, 

hurricane winds and storm surge, earthquakes, and tsunamis. 

Shapefile: Geospatial vector data format for GIS software. 

Study Region: Area in which data are being collected or analyzed.  
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